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About Event Source Management
The Event Source module in NetWitness Suite provides an easy way to manage event sources 
and configure alerting policies for your event sources.

Workflow
This workflow shows the overall process for managing event sources, and configure monitoring 
for them. It also shows where configuring alarms and alerts settings are located in the process.

Prerequisites
There are two permissions that affect Event Source Management:
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 l View Event Sources is needed for users to view event sources, their attributes, and their 
thresholds and policies.

 l Modify Event Sources allows users to add, edit, and otherwise update event sources.

For details, see the following topics:

 l The Roles Tab topic available in the System Security and User Management guide > 
References > Administration Security View > Roles Tab. 

 l The Role Permissions topic describes the built-in NetWitness Suite system roles, which 
control access to the user interface. Available in the System Security and User 
Management guide > How Role-Based Access Control Works.

 l The Manage Users with Roles and Permissions topic describes how to manage users in 
NetWitness Suite, using roles and permissions. Available in the System Security and User 
Management guide > Manage Users with Roles and Permissions.

Automatic Mapping
Introduced in RSA NetWitness® Suite version 11.1, the system automatically maps incoming 
events to a type based on previous logs received from that address, reducing the mis-parsing of 
messages and reducing the number of items that need attention in the Discovery workflow. The 
UI indicates that an address has been auto-mapped in the Discovery workflow.

Navigate to Event Source Management
You can view the details about your existing event source groups by doing the following:
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 1. Go to ADMIN> Event Sources.

 2. Click any of the following:

 l The Discovery tab. Use this tab to review the event source types that NetWitness has 
discovered for each address and the system’s confidence of how likely it is that they were 
identified completely accurately.

 l The Manage tab. This tab allows you to add, edit, and delete event source groups as well 
as  viewing details for your existing event source groups.

 l The Monitoring Policies tab. Use this tab to view or edit your event source alerting 
configuration.

 l The Alarms tab. Use this tab to see the details of the alarms that have been generated. 
Alarms are generated when event sources exceed or fall below their set thresholds.

 l The Settings tab. Use this tab to view or change the behavior for automatic alerts.

 l The Log Parser Rules tab. Use this tab to view log parser rules as well as viewing how 
those rules will parse specified logs.

Note: When the system receives logs from an event source that does not currently exist in the 
Event Source List, NetWitness Suite automatically adds the event source to the list. 
Additionally, if it matches the criteria for any existing group, it becomes part of that group.
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How Alarms and Notifications Work
The Event Source module in NetWitness Suite displays alarms and sends notifications based on 
alarms that are triggered.

For alarms, consider the following:

Alarms are of two types: automatic (triggered when baselines are exceeded or not met) 
and manual (configured using thresholds).

 l Automatic: If you turn on automatic alerts, the system reports alarms for all event sources 
that go above or below their normal baselines by the required amount. You can specify the 
over / under percentage on the Settings Tab.

 l Manual: The system alerts whenever an event source exceeds the thresholds in the policy for 
the associated groups.

 l Alarms appear on the UI, in the Alarms Tab.

For notifications, consider the following:

 l To receive manual notifications (via email, SNMP or Syslog):

 l Specify a policy for an event source group.

 l Set a high or low (or both) threshold.

 l Enable the policy.

 l To receive automatic (baseline) notifications:

 l Baseline alerting must be on. This is turned on by default.

 l You must enable notifications from automatic monitoring. See Configuring Automatic 

Alerting for details.

 l The event source that triggers the alarm must be in a group that has a policy enabled.

 l If you have automatic alerting turned on, and you have configured a policy and threshold for a 
group:

 l If the event source goes outside its baseline, you see an automatic alert and receive a 
notification.

 l If the event source goes outside its thresholds, you see a manual alert and receive a 
notification.

 l If both occur (threshold and baseline exceeded or not met), you receive two alarms (visible 
on the Alarms tab) and a notification that indicates both alarms. That notification will list 
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the event source that double alarmed twice; one listing indicating it was an automatic 
alarm.

Large Email Notifications

If you have set up email notifications, keep in mind that the email can grow very large, 
depending on the number of event sources in the notification.

If the number of event sources in the alarmed state exceeds 10,000, then the email notification 
contains the details for only the first 10,000 and a total count. This is to ensure that the email is 
successfully delivered.

The following examples show a low threshold triggered for two event source groups and a high 
threshold triggered for three event source groups. 

High and Low Thresholds Both Triggered

There may be occasions when both the high and low alarms are both triggered for a particular 
event source group. The easiest way to see when this happens is to read the email header, which 
clearly states when both thresholds are triggered, as shown in this image:
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In this example, the header states, "High threshold and Low threshold triggered on ciscopix 
group." To see the details for the low threshold event sources, you may need to scroll down past 
hundreds, or even thousands, of the high threshold event sources.

Automatic Alerting
This topic describes automatic alerts, which are based on baseline settings.

Note: Automatic alerting, and all of the parameters that determine its behavior, are currently 
in Beta testing.

You can set up policies and thresholds for your event source groups. You do this so that you 
receive notifications when the thresholds are not met. NetWitness Suite also provides an 
automatic way to receive alarms, if you do not want to set up thresholds to generate alarms.

To trigger automatic alerts, you can use baseline values. This way,  you do not need to set up 
numerous group thresholds and policies in order to receive alerts. Any anomalous amount of 
messages trigger alerts, without needing to do any configuration (except for turning on automatic 
alerting).

Note the following:

 l Once you begin collecting messages from an event source, it takes the system approximately 
a week to store a baseline value for that event source. After this initial period, the system 
alerts you when the number of messages for a period are above or below the baseline by a set 
amount. By default, this amount is 2 standard deviations above or below the baseline.

 l Base your high and low deviation settings on how "regular" your event sources behave. That 
is, if you expect little or no variance in the number of messages that arrive for a given time 

About Event Source Management 12



Event Source Management User Guide

(for example, 8 to 9 am on a weekday), then you can set a low value for the Deviation. 
Conversely, if you often see peaks and valleys, set the Deviation value higher.

 l If you enable a policy, but do not have any thresholds set, then you can still receive automatic 
(baseline) notifications, as long as you have turned on automatic alerting.

Common Scenarios for Monitoring Policies
Typically, organizations monitor their event sources in "buckets" based on how critical the event 
sources are. One typical example is as follows:

 l There is a group of PCI devices, and it is critical to know if any of these devices stop sending 
messages (or send too few messages) within a half hour.

 l There is a group of Windows devices, and it is useful to know if any of these devices stop 
sending messages after four hours.

 l There is a group of quiet devices that do not typically send a lot of messages, but you would 
like to know if they do not send anything for 24 hours.

Many organizations may have a network that resembles this example. You may have more or 
different categories, but this example is used to discuss this feature.

You may have dozens or even hundreds of event source groups, and still only have a few groups 
for which you need to set thresholds and alerts. 

Note: If an Event Source is a member of multiple groups that have alerting configured, it will 
only alert on the first matching group in the ordered list. (The Monitor Policies tab presents an 
ordered list of your groups.)

Ordering the Groups

Note: To change the order of the groups, drag and drop a group to its new location. The higher 
a group is listed, the higher the precedence for that group's thresholds: RSA NetWitness 
Suite checks the thresholds in the order provided in this panel. Thus, your highest priority 
groups should be at the top of this list.

The first thing to keep in mind is how to order your groups on the Monitoring Policies page. 
Assuming that you have the three groups mentioned above, you should order them as follows:

 1. Quiet event sources. Having this group first ensures that you will not get numerous false 
alerts.

 2. High priority PCI event sources. The highest priority devices should be after the quiet 
devices
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 3. Windows event sources. The time range is longer (four hours versus a half hour) for these 
devices than for the PCI devices. Therefore, they should come after the PCI devices.

 4. All event sources. Optionally, you could set thresholds for all devices as a catch-all. 
This ensures that your entire network is operating as expected. For the catch-all group, you 
do not need to specify any thresholds—you can use automatic alerting to generate alarms for 
the event sources in this group.

In the figure above, note the following:

 l The groups are ordered as discussed in the previous section.

 l The threshold for PCI devices is to alert if the number of messages coming in to NetWitness 
Suite is fewer than 10 messages in 30 minutes.

 l A low threshold is defined, but not a high threshold. This is typical for many use cases.

After you have set up and ordered your groups and begun to receive alerts, you may need to 
adjust the order. Use these guidelines to help you adjust the ordering:

 l If you receive more notifications than you need, you can move the group down in the order. 
Similarly, if you are getting too few notifications, move the group up towards the top.

 l If you notice that one event source is creating more alerts than it should, you can move it to 
another group, or create a new group for that event source.
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Definitions

When dealing with event source groups in NetWitness Suite, note the following:

 l An event source is essentially the combination of values for all of its attributes.

 l An event source group is the set of event sources that match a set of criteria that are defined 
for that group.

For example, you might have the following groups:

 l A group named Windows Devices, consisting of all the event source types associated with 
Microsoft Windows event sources (winevent_nic, winevent_er, and winevent_snare).

 l A group named Low Priority Services, consisting of all services where the Priority attribute 
has been set lower than 5.

 l A group named U.S. Sales Servers, where you gather event sources located in the U.S.A. 
and having an Organization attribute of Sales, Finance, or Marketing.

Manage Tab Details

The Manage tab in the Event Source module provides an easy way to manage event sources. In 
this tab, you can:

 l Set up event source groups in a consistent way.

 l Work with event source attributes in a consistent, straightforward manner.

 l Easily search through your entire set of event sources.

 l Bulk edit and update your event sources and event source groups.

You can view the details about your event source groups by doing the following:

 1. Go to  ADMIN > Event Sources.

 2. Select the Manage panel to see the details for your existing event source groups.

Note: When the system receives logs from an event source that does not currently exist in the 
Event Source List, NetWitness Suite automatically adds the event source to the list. 
Additionally, if it matches the criteria for any existing groups, it becomes part of that group.

Default Groups

RSA NetWitness Suite has several default groups. You can customize these as required and use 
them as templates for creating new groups.

15



Event Source Management User Guide

The default groups are as follows:

 l All Event Sources

 l All Unix Event Sources

 l All Windows Event Sources

 l Critical Windows Event Sources

 l PCI Event Sources

 l Quiet Event Sources

You can edit any of these groups to investigate the rules that define the groups.

Note: You cannot edit or delete the All event source group.

Creating Event Source Groups
Administrators must receive notifications when event sources are no longer being collected by 
NetWitness Suite. They need to be able to configure how long the event sources can be quiet 
(that is, not collect any log messages) before sending a notification based on different factors.

RSA NetWitness Suite provides event source groups so that you can group similarly important 
devices together. You can create groups based on attributes that you imported from your CMDB 
(configuration management database), or by manually choosing event sources to add to the 
group.

For example, these are some of the types of event source groups that you can create:

 l PCI sources

 l Windows Domain Controllers

 l Quiet sources

 l Finance Servers

 l High Priority devices

 l All Windows sources

Procedure

To create an Event Source group:

 1. Go to ADMIN  > Event Sources.

 2. In the Manage panel, click  .

The Create an Event Group dialog is displayed.
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 3. Enter a Group Name.

 4. Enter a Description.

 5. Click  to add a condition. Continue adding conditions as necessary. For details on 

constructing conditions, see Create/Edit Group Form.

 6. Click Save.

The new group is listed in the Manage panel.

Examples

This section describes a simple example, and then discusses how to set up a more complex set 
of rules.

Simple Example

If you want to create an event source group that contains all of your high priority event sources, 
this example describes the necessary steps.

 1. Go to  ADMIN > Event Sources.

 2. In the Manage > Groups panel, click  .

 3. Enter High Priority Devices for the Group Name.

 4. Enter a description, such as, "These devices are our highest priority ones, and must be 
monitored closely."
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 5. Leave All of these selected and click  to add a condition.

 6. Select Add condition from the drop-down menu.

 a. Select an Attribute: Priority.

 b. Select an Operator: Less than.

 c. Enter a value: 2.

The following figure displays the updated Edit Event Group dialog.

 7. Click Save.

Complex Example

In this example, you want to create a fairly complex rule: match event sources that are in the 
United States, and in either the Sales, Finance, or Marketing departments. Also, match 
worldwide internal, high priority Sales event sources. High Priority is assumed to be where the 
priority is 1 or 0. Logically, the definition is as follows:

(Country=United States AND (Dept.=Sales OR Dept.=Finance OR 
Dept.=Marketing))
 OR
 (Priority < 2 AND Division != External AND Dept.=Sales)

The following figure is an example of the criteria for creating such an Event Source Group.
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Creating Event Source Group Form
The Create Event Source Group form is displayed when you are creating or editing an Event 
Source Group.

Parameters

The following table describes the fields on the Create/Edit an Event Group form.

Field Description

Group 

Name

This field is required, and appears throughout the NetWitness Suite UI as the 
identifier for the group.

Description An optional description to help describe the purpose or details for the group.
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Field Description

Tools The following items are available on the toolbar:

 l Add (+): clicking the Add displays a menu where you can choose to add a 

condition or a group.

 l Remove (-): removes the selected rule or group of rules from the list.

When you add a new group, that has the effect of creating nested levels of 
conditions.

Conditions Described below, in the Rule Criteria table.

Cancel / 

Save

Cancel and Save options are available in the form.

Rule Criteria

The rules that you specify determine the event sources that will become part of this event source 
group. A rule consists of the following:

 l Grouping: how the rule interacts with other rules

 l Attribute: which attribute the rule is matching against

 l Operator: how the rule matches the attribute

 l Value: the attribute value used for the rule

The following table provides details on these rule constructors.
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Rule 
Constructor

Details

Grouping You can group conditions, in order to create complex rules for an event 
source group. The following choices are available when grouping your rules:

 l All of these: logically equivalent to AND

 l Any of these: logically equivalent to OR

 l None of these: logically equivalent to NOT

If you are creating a simple group, and specifying a single condition, you can 
leave the default value (All of these) selected.

Attribute This contains a drop-down list, consisting of all event source attributes. The 
attributes are displayed by the section to which they belong. For example, all 
of the Identification attributes are displayed first, followed by the 
Properties, Importance, and so on.
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Rule 
Constructor

Details

Operator Choose from the following options:

 l Equals: matches the provided value

 l Not equals: returns event sources whose specified attribute not equal to 
the provided value

 l In: provide a list of values in comma separated format, and event sources 
that match any of the provided values are included. For example:

Where IP in 10.25.50.146, 10.25.50.248

This condition returns event sources that have either 10.25.50.146 
or 10.25.50.248 as their IP attribute.

 l Not in: similar to In, except that it matches items whose attribute is not 
equal to any of the listed values.

 l Like: matches items that begin with the provided string. For example:

Where Event Source Type Like Apache

This condition returns event sources whose Event Source Type begins 
with Apache.

 l Not like: similar to Like, except that it matches items whose attribute 
does not begin with the provided string.

 l Greater than: matches items whose attribute is greater than the provided 
value. For example, if you specify Priority Greater than 5, the condition 
would match any item with a priority of 6 or higher.

 l Less than: similar to Greater than. Matches items whose attribute is 
less than the provided value.

Value Enter a value or group of values. The value type depends on the attribute for 
the condition. For example, for IPv6, you need to specify a value in 
IPv6 format.

Acknowledging and Mapping Event Sources
In RSA NetWitness® Suite version 11.1, RSA introduced Automatic Mapping. The system 
automatically maps incoming events to a type based on previous logs received from that address, 
reducing the number of items that need attention in the Discovery workflow. The UI indicates 
that an address has been auto-mapped in the Discovery workflow.
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Acknowledge Event Source Types

The Discovery tab lets you review the event source types that NetWitness has discovered for 
each address and the system’s confidence of how likely it is that they were identified accurately.  
If the discovered event source types are correct, you can acknowledge to filter out that event 
source from the view by default.  If incorrect, you can set the allowed event source types for a 
particular address so that future logs will parse against the correct parsers.

To acknowledge event sources:

 1. Go to ADMIN > Event Sources.

The Discovery tab is displayed.

 2. Select one or more event sources.

 3. Click Toggle Acknowledge.

Note the following:

 l Once Event Sources are Acknowledged, they are no longer displayed in the Event Source 
Type(s) column.

 l The Toggle Acknowledge button behaves as follows:

 l If the Acknowledged state for all of the selected event sources is the same, all values are 
toggled. That is, if you select only event sources with Yes in Acknowledged column, the 
value changes to No for all of them. Similarly if they all have No in the Acknowledged 
column, the value changes to Yes for all selected event sources.

 l If you select a multiple event sources, and the value for some is Yes and for other it is No, 
when you click Toggle Acknowledge, all of the values are set to Yes for the selected 
event sources.

Note: Acknowledged Event Sources are not displayed by default.

Manually Map Event Source Types

When discovered event source types are not completely accurate, you can manually map the 
parsers to obtain additional information.

To map one or more event sources:

 1. Go to ADMIN > Event Sources.

The Discovery tab is displayed.

 2. Select one or more event sources.
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 3. Click .

The Manage Parser Mappings dialog box is displayed.

 4. Add or remove parser mappings, and change the priority order, based on the needs of your 
organization. For more details, see Manage Parser Mappings .

Note: Discovery scores for the mapped Event Sources are listed in the Event Source Type(s) 
column from the lowest to highest discovery scores. Discovery scores range from 0 (least 
confident) to 100 (most confident).

Viewing Logs from Pre-11.0 Log Decoder

RSA NetWitness® Suite 11.0 added the capability to view a small sampling of recent logs for 
specific devices through detail tabs of the Discovery View. By default, Log Decoders prior to 
11.0 do not have the necessary configuration to enable this feature, but a few minor changes can 
make it available. For more details, see Viewing Logs from Pre-11.0 Log Decoder.

Editing or Deleting Event Source Groups
You may occasionally need to remove an event source group. For example, if you close an 
office, and you had a group consisting of all the event sources in that office, you can remove the 
group, since none of those event sources will send information to NetWitness Suite.

Similarly, you may need to change some of the conditions that are used to populate the group.

Note: You cannot edit the event source group name. Once you create a group, that name 
exists as long as the group itself exists.

Edit an Event Source Group

 1. Go to ADMIN > Event Sources.

 2. In the Manage panel, select an existing Event Source Group.

 3. Click .

The Edit Event Group dialog is displayed.

 4. Modify any of the details, or add, edit or remove conditions as necessary.

 5. Click Save.

Delete an Event Source Group

Note the following:
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 l You can delete any group except for the All group, which lists all configured event sources in 
the system.

 l If you delete a group, the associated policy for that group also gets deleted automatically.

 l If there are any event sources that belong only to the deleted group, they would no longer 
have a policy alarm associated with them. Remember that event sources can belong to 
multiple groups.

 l Deleting a group has no effect on baseline alarms.​

To delete an event source group:

 1. Go to ADMIN > Event Sources.

 2. In the Manage panel, select an existing Event Source Group.

 3. Click .

A confirmation dialog is displayed.

 4. Click Yes to delete the group.

Creating an Event Source and Editing Attributes
You can organize your event sources into groups. You do this by entering values for various 
attributes for each event source. For example, for all of your high priority event sources, you 
could set the Priority to 1. You can see details about the available attributes on the Manage 
Event Source Tab.

The following figure shows an example of the Event Sources panel:
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Event source attributes are a combination of auto-populated and user-entered information. When 
an event source sends log information to NetWitness Suite, it is added to the list of event 
sources, and some basic information is auto-populated. At any time after that, users can add or 
edit details for other event source attributes.

Mandatory Attributes

The following identification attributes are handled specially: IP, IPv6, Hostname, Event 
Source Type, Log Collector, and Log Decoder. If you create an event source manually, you 
can enter these values. Once you save the event source, these values can no longer be changed.

Event sources can also be auto-discovered; any event source that sends messages to the Log 
Decoder will be added to the list of event sources. If you edit the attributes for an auto-
discovered event source, you cannot edit any of these fields.

Note that not all of these fields are mandatory. To uniquely identify an event source, the 
following information is required:

 l IP or IPv6 or Hostname, and

 l Event Source Type

Additionally, RSA NetWitness Suite uses a hierarchy for IP, IPv6, and Hostname. The order is 
as follows:

 1. IP

 2. IPv6

 3. Hostname

If you enter event sources manually, then you need to keep this order in mind, otherwise, you 
may end up with duplicates when messages are received from the event sources that you 
manually added.

All other attributes (such as Priority, Country, Company, Vendor, and so on) are optional. 

Create an Event Source

 1. Go to ADMIN > Event Sources.

 2. Select the Manage tab.

 3. In the Event Sources panel, click  to open the details screen, which contains all of the 
event source attributes.

The Manage Event Source Tab is displayed.

 4. Enter or change the values for any attributes.

 5. Click Save.
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Update Attributes for an Event Source

 1. Go to ADMIN> Event Sources.

 2. Select the Manage tab.

 3. In the Event Sources panel, select an event source from the list.

 4. In the Event Sources panel, click  to open the details screen, which contains all of the 
event source attributes.

The Manage Event Source Tab is displayed.

 5. Enter or change the values for any attributes, except for certain attributes that cannot be 
altered once entered.

 6. Click Save

Bulk Editing Event Source Attributes
You can select multiple event sources, or an entire group, or even all event sources for bulk 
editing. For example, you might want to change the Priority or the Manager for a large number 
of your event sources.

Note: You cannot select individual event sources across displayed pages. For example, if you 
have a group with 225 event sources, and your Page Size is 50, you can only select event 
sources from the currently displayed 50 items.

  If you want to edit items that span multiple pages, you can do the following:

 l In the browser, increase the page size (the maximum is 500 entries on a single page). If your 
page size is small, you might be able to get all of your items on a single page.

 l Create a new event source group that contains only the items that you want to bulk edit. Then, 
you can select all items for that group, rather than selecting individual items.

 l Bulk edit incrementally. On the first page, select the items that you want to edit. Make your 
edits, then go to the next page and repeat the process, until you have made all of your 
changes.

Bulk Edit Attributes

Note: Mandatory fields cannot be edited; IP, IPv6, Hostname, Event Source Type, Log 
Collector, and Log Decoder.

To bulk edit attributes for Event Sources:
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 1. Go to ADMIN > Event Sources.

 2. Select the Manage tab.

 3. Optionally, select an event source group.

 4. In the Event Sources panel, select one or more event sources to edit.

Note: To select all event sources, select the box next to the Actions column in the last 
(far-right) column of the list table.

 5. Select the Edit icon  from the menu bar.

The Bulk Edit Event Source dialog is displayed.

 6. Enter values for any of the available attributes. In the screen shot above, the Name and 
Priority attributes have been updated.

 7. When you have updated as many attributes as required, click Save.
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Importing  Event Sources
You can import event source attributes from a CSV-formatted file. To import information from a 
configuration management database (CMDB), a spreadsheet, or other type of file, first convert 
or save the information to a CSV file.

Note: The following identification attributes are handled specially: IP, IPv6, Hostname, 
Event Source Type, Log Collector, and Log Decoder. If you import an event source that 
includes a different value for any of these fields (when compared with the value in 
NetWitness Suite), the original value in NetWitness Suite will not be overwritten.

The imported attributes are associated with the matched Event Source and are available for use 
in rules to create Event Source Groups.

RSA NetWitness Suite treats the import file as the correct, complete record. This assumption 
leads to the following behaviors related to importing event source attributes:

 l By default, when you import attributes, the system updates attributes for existing event 
sources only.

 l If the event source exists in the import file, but not in NetWitness Suite, the attributes for that 
event source are ignored. That is, NetWitness Suite does not create a new event source for 
these attributes.

 l If the event source exists in both the import file and NetWitness Suite, values for that event 
source are overwritten.

 l If an attribute is blank in the import file, it clears the corresponding attribute in NetWitness 
Suite.

 l If an attribute is not specified in the import file, then the corresponding attribute is ignored in 
NetWitness Suite (that is, it is not cleared).

Note: There is a difference between a blank attribute vs. one that is not specified at all. If an 
attribute is specified but blank, the assumption is that it is meant to be blank, and NetWitness 
Suite clears that attribute for the corresponding event source. However, if an attribute is not 
specified at all, it is assumed that no change is expected.

The above behaviors are the defaults—you can change the behavior as specified in the following 
procedure.

Import Event Source Attributes

To import Event Source attributes from a file:
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 1. Go to ADMIN > Event Sources.

 2. Select the Manage tab.

The Event Sources Manage tab is displayed.

 3. From the Import/Export menu in the toolbar ( ), select Import ( ).

The Import Event Sources dialog is displayed.

 4. Navigate to the import file, and select the appropriate boxes:

 l Default: The default behavior is described above.

 l Add only: Imports an attribute only if the corresponding field in NetWitness Suite is 
blank. Thus, no existing values will be overwritten.

 l Do not clear values: Does not clear attribute values in NetWitness Suite for items in the 

30



Event Source Management User Guide

import file that are blank.

 l Add Unknown Sources: Adds new event sources based on items in the import file.

Note: You can select multiple options.

 5. Click Import.

 6. Click Yes in the confirmation dialog to perform the import.

Troubleshooting the Import File

If your import file is not formatted correctly, or is missing required information, an error is 
displayed, and the file is not imported.

Check the following:

 l If you are adding unknown sources, each line in the file must contain a combination of the 
required attributes: 

 l IP or IPv6 or Hostname, and

 l Event Source Type

 l The first line of the file must contain header names, and the names must match the names in 
NetWitness Suite. To get a list of correct column names, you can export a single event 
source. Examine the exported CSV file: the first row of the file contains the correct set of 
attribute/column names.

If your import file is not formatted correctly, or is missing required information, an error is 
displayed, and the file is not imported.

Exporting Event Sources
You can export all or some of your event sources, along with their corresponding attributes, to a 
CSV file.

Note the following:

 l The exported CSV includes all attribute columns.

 l The exported CSV includes a header line at the top, listing each column name.

 l You can export all entries in a group.

 l You can export all entries (select the All group).

 l You can select entries and export only those entries.
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Export Event Sources

To export your Event Sources:

 1. Go to ADMIN > Event Sources.

 2. Select the Manage tab.

The Event Sources Manage tab is displayed.

 3. Select the group that contains the event sources to export.

 4. Select as many event sources as you need. Alternatively, you can export the entire group: to 
export the entire group, you do not need to select any individual event sources.

 5. From the Import/Export menu in the toolbar ( ), select Export (.csv) or Export 
Group (.csv).

The Export Event Sources dialog is displayed.

 6. Enter a file name and click export.ddd

The event source attributes are saved to the file name you specified, in a CSV format.
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Sorting Event Sources
The event sources panel displays attributes for the currently selected event source group. You 
can configure the list of attributes that are displayed, as well as sort the list on any of the 
displayed attributes. 

Note: The entire list is sorted, not just the items displayed on the current page. (The 
navigation bar at the bottom of the page shows how many pages exist for this list of event 
sources.)

To sort your event sources:

 1. Go to ADMIN > Event Sources.

 2. Select the Manage tab.

The Event Sources Manage tab is displayed.

 3. To sort a column, click  in the column header.

 The Sort Options drop-down menu is displayed.

 4. Select the sort order that you want.
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Monitoring Policies
Use the Monitoring Policies view to manage alert configuration for your event source groups.

You can create policies that alert on event source groups, by setting thresholds and notifications:

 l Thresholds set ranges for frequency of log messages. You can specify a low threshold, a high 
threshold, or both.

 l Notifications describe how and where to send alerts when thresholds are not met.

 l You combine thresholds and notifications to create alerts based on the frequency you specify.

 l If automatic alerting is enabled (it is by default), you can create and enable a policy without 
setting any thresholds. If you then  turn on automatic notifications, notifications will be sent 
whenever an event source in the group is above or below its baseline by the specified amount.

For example, let's say that you have created an event source group that consists of all your 
Windows event sources based in the United Kingdom. You could specify a policy that alerts you 
whenever fewer than 1000 events per 30 minutes arrive.

Note: In addition to, or instead of setting up monitoring policies for your event source groups, 
you can Configuring Automatic Alerting to view alarms when the number of messages for an 
event source are outside of the normal bounds.

Configuring Event Source Group Alerts
Each event source group can have its own alerting policy. This includes setting the thresholds for 
when to alert, and setting the notification type when an alert is triggered. This topic describes 
the steps involved in creating an alert policy for an event source group.

Procedures

Create an Alert Policy for an Event Source Group

 1. Go to ADMIN > Event Sources.

 2. Select the Monitoring Policies tab.

 3. In the Event Groups panel, select a group.

 4. Enter values for the Low Threshold and High Threshold fields.

This is an example of alert thresholds.
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 5. Select Enable and click Save to enable the alert policy that you have configured.

Note: If you make changes to a policy, and attempt to exit the page before you save your 
changes, an Unsaved Changes warning message is displayed:

Set and View the Thresholds for an Alert Policy

Every event source group is also an alert policy. Thresholds are part of an alert policy. You can 
set thresholds for each alert policy. For each policy, you can set a low threshold, a high 
threshold, or both. Additionally, you can enable a policy without setting any thresholds; this 
allows you to receive notifications based on automatic alerts. Automatic alerts are generated 
when the baseline for an event source is out of normal bounds.

 1. Go to  ADMIN > Event Sources.

 2. Select the Monitoring Policies tab.

 3. In the Event Groups panel, select a group.
 Any thresholds set for the selected group are displayed in the Thresholds panel.

 4. Edit the values in either the Low or High Threshold as follows:

 a. Enter the number of events for the threshold.

 b. Enter the number of minutes or hours for the threshold. The minimum value is 5 minutes.

Note: For each threshold, you can set either the low values, the high values, or both.

 5. Select Enable to enable alarms when thresholds are not met.
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Note: If you configure a threshold and attempt to save the page without enabling it, you 
receive a confirmation message, asking you whether or not to enable the policy: ddd

For example, suppose you enter 10 and 30 for the values for the low threshold: 10 events in 
30 minutes, and 20 and 30 for the values for the high threshold: 20 events in 30 
minutes. This means that you expect between 10 to 20 events are logged in 30 minutes (for the 
selected event source group). That is, anything between the low and high threshold is considered 
normal, and does not trigger an alarm.

Note: Once you add a threshold for a policy, you cannot delete it. You can disable the policy, 
or set the low or high threshold to 0 events in 5 minutes. Five minutes is the minimum duration 
for a threshold.

Setting Up Notifications
This topic describes how to configure notifications for event source groups. Notifications are 
sent when thresholds are not met.

Notifications go hand-in-hand with Thresholds. Before you configure notifications, you should 
set up Thresholds for an event source group.

Note: After configuring the thresholds for an event source group, if you do not set any 
notifications, then even if an alarm is triggered, users are not notified. However, all alarms 
are visible on the Alarms Tab.

Prerequisites

Before you set up notifications for an event source group, you should review the available 
notification items:

 l Notification Servers: These are the servers that you want to receive notifications from the 
system. For more details, see the Notification Servers Overview topic in the System 
Configuration Guide.

 l Notification Templates: These are the available templates for each type of notification. For 
Event Source Management, default templates are supplied for Email (SMTP), SNMP, 

36



Event Source Management User Guide

and Syslog. You can use these templates as supplied, or customize them if necessary. For 
more details, see the Templates Overview topic in the Systems Configuration Guide.

 l Notification Output: The outputs contain the parameters for the notification type. For 
example, an email notification type contains the email addresses and subject for the 
notification. For more details, see the Notification Outputs Overview topic in the Systems 
Configuration Guide.

Add Notifications for an event source group

To add notifications for an event source group:

 1. Go to  ADMIN > Event Sources.

 2. Select the Monitoring Policies tab.

 3. In the Event Groups panel, select a group.

Note: You should have already set a threshold for the group. If not, see Set and View the 
Thresholds for an Alert Policy to set a threshold, and then return to this procedure. 
Alternatively, if you have automatic alerting turned on, then you do not need to set 
thresholds for a policy. Automatic alarms generate notifications without the need to set 
thresholds.

 4. In the Notifications panel, click , and from the drop-down menu, select the type of 
notification you want to add:

 l Email

 l SNMP

 l Syslog

Note: Default ESM (Event Source Monitoring) templates are provided for each type of 
notification.

 5. Enter values for the Notification, Notification Server, and Template fields.

 a. For Notification, select from the list, or add a suitable notification type in Notifications, 
and then select it here.

 b. For the Server, select one from the list, or add a suitable server in Notifications, and 
then select it here.

 c. For Template, select an available template, or create a suitable template in 
Notifications, and then select it here.
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Note: If you need to add or edit one of these items, click Notification Settings. A new 
browser window opens on the Administration > System > Global Notifications page. 
Use this page to view or update the available Notification items.

 6. Optionally, you can limit the rate of notifications for a policy.

 a. Select Output Suppression to enable setting a limit.

 b. Enter a value, in minutes, for the suppression rate. For example, if you enter 
30, notifications for this policy are limited to one notification every 30 minutes.

 c. Click Save.

Here is an example of a monitoring policy that contains a threshold and notification for an event 
source group.

Disabling Notifications
Notifications are sent when thresholds are not met. Additionally, automatic notifications are sent 
when baselines are not met. However, you may determine that you no longer require 
notifications for the event sources in a particular group. In this case, you can disable 
notifications for the event source group.

Note: Even if you disable all notifications, the details for alarms are still visible on the Alarms 
Tab.
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Prerequisites

You must have configured thresholds and notifications for an event source group, and enabled 
them. For automatic notifications, you must have selected Enable Notifications From 
Automatic Monitoring on the Alarms Tab

Disable Notifications

To disable notifications (both manual and automatic) for an event source group:

 1. Go to  ADMIN> Event Sources.

 2. Select the Monitoring Policies tab.

 3. In the Event Groups panel, select a group.

 4. Click Enable to remove the check mark. Clearing this option means that notifications are not 
sent for this event source group, even if thresholds are not met or exceeded.

 5. Additionally, you can remove all notifications. However, this is not required to stop the 
notifications.
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Viewing Event Source Alarms
This topic describes how to view alarms for your event source groups. Once you have 
configured and set alerts, you can view all of the generated alarms in the Alarms tab of the 
Event Sources view.

Sort the Alarms Information
When you first access this view, the data is sorted by most recent alarm (the Alarmed 
time column). You can sort by any column.

 1. Go to ADMIN> Event Sources.

 2. Mouse over a column that you want to sort.

 3. Click the Select the Alarms tab.

 4. Mouse over the column that you want sorted, and click the  icon.

This is an example when you mouse over the Alarm column.

 5. Select either Sort Ascending or Sort Descending to sort the column in the way you wish.

The data is sorted across all pages.
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Note: You can also sort by two columns. To do this, first sort by the secondary column, then 
sort by the primary column. For example, if you want to see all the HIGH alarms by their 
group order, first sort on Group, then sort on Alarm.

Filter Alarms by Type
You can also filter the alarms by their type: you can display only the Manual or Automatic 
(baseline) alarms. To filter by alarm type, select the filter icon on the right side of screen, in the 
heading area:

Select either Automatic or Manual:

 l If you select Automatic, only the alerts based on baselines are displayed.

 l If you select Manual, only the alarms for which you have set thresholds are displayed.
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Note: Automatic alerting, and it settings, are currently in Beta testing.

Prerequisites
Before you set up notifications for an event source group, you should review the available 
notification items:

 l Notification Servers: These are the servers that you want to receive notifications from the 
system. For more details, see the Notification Servers Overview topic in the System 
Configuration Guide.

 l Notification Templates: These are the available templates for each type of notification. For 
Event Source Management, default templates are supplied for Email (SMTP), SNMP, 
and Syslog. You can use these templates as supplied, or customize them if necessary. For 
more details, see the Templates Overview topic in the Systems Configuration Guide.

 l Notification Output: The outputs contain the parameters for the notification type. For 
example, an email notification type contains the email addresses and subject for the 
notification. For more details, see the Notification Outputs Overview topic in the Systems 
Configuration Guide.

To configure automatic alerting:

 1. Go to  ADMIN > Event Sources.

 2. Select the Settings tab.

The Settings tab is displayed.
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 3. By default, automatic monitoring is turned on. To turn off automatic alerting, clear the 
Enable Automatic Monitoring option.

 4. By default, notifications for automatic alerts is turned off. To turn on automatic notifications, 
select the Enable Notifications From Automatic Monitoring option.

 5. Configure the parameters, based on your usage patterns:

 l Low Standard Deviations: standard deviations below which to receive alerts. Default is 
2.5 (95% confidence).

 l High Standard Deviations: standard deviations above which to receive alerts. Default is 
2.5 (95% confidence).

Note: You can adjust the standard deviation settings in increments of 0.1 (one tenth) of a 
standard deviation.

 6. Click Save to close the dialog and save your settings.
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Event Source Management References
The following topics contain reference information for Event Source Management:

 l Discovery Tab

 l Manage Tab

 l Manage Event Source Tab

 l Event Sources View

 l Create/Edit Group Form

 l Details View

 l Manage Parser Mappings 

 l Alarms Tab

 l Monitoring Policies Tab

 l Settings Tab

 l Log Parser Rules Tab

 l Default Log Parser and Log Parser Rules 
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Discovery Tab
To access the Discovery tab, go to NetWitness ADMIN> Event Sources. The Discovery tab is 
displayed.

The Discovery tab lets you review the event source types that NetWitness has discovered for 
each address and the system’s confidence of how likely it is that they were identified completely 
accurately.  If the discovered event source types are correct, you can acknowledge to filter out 
that event source.  If incorrect, you can set the allowed event source types for a particular 
address so that future logs will parse against the correct parsers.

Note: The following features apply to RSA NetWitness® Suite version 11.1 and later:
- Acknowledging multiple event sources 
- Filtering by event source type
- Mapping filter options include None, Auto, and Manual.
- Mapping multiple event sources
- Searching for event sources on the Event Source Discovery page

Introduced in RSA NetWitness Suite version 11.1, the system automatically maps incoming 
events to a type based on previous logs received from that address,  reducing the mis-parsing of 
messages and reducing the number of items that need attention in the Discovery workflow. A 
value of Auto in the Mapping Type column indicates that an address has been auto-mapped.

Workflow
This workflow shows the overall process for configuring event sources.

What do you want to do?
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Role I want to... Documentation

Administrator Acknowledge and map event sources.* Acknowledging and 

Mapping Event 

Sources

Administrator Add and configure parser mappings for a Log 
Decoder.*

Manage Parser 
Mappings 

Administrator View event source alarms. Viewing Event 

Source Alarms

Administrator View log parser rules. Default Log Parser 
and Log Parser Rules 

Administrator Troubleshoot event source management. ESM 
Troubleshooting 
& Appendix

*You can perform this task here.

Related Topics
Manage Parser Mappings 

Details View

Quick Look
The following example displays a list of addresses and their discovered Event Source types. The 
Event Source types display the Event Sources that have been discovered.

This is an example of the tab.
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1 Displays the Filters and Event Sources panels with the Discovery tab open.

2 Displays the Event Source Filter field with a drop-down menu that offers the following 
options:

 l Enter the full or partial address (IP, IPv6 or Hostname) of the source(s) you want to 
review. You can also enter multiple entries that are separated by commas. 
For example, 10.10.10.10,10.10.10.11,host1.company.com

 l Exact: Returns sources that completely match the search term.
For example, 10.10.10.10 only returns 10.10.10.10, not 10.10.10.101.

 l Starts With: Returns sources that start with the search term. 
For example,10.10.10. returns the whole 10.10.10.x subnet.

 l Contains: Returns sources that start with the search term.  
For example, exch returns all terms such as us-exch-1.company.com, or lab21 returns 
all hostx.lab21.company.com terms.

 l Ends With: Returns sources that end with the search term.
For example, lab21.company.com returns all hosts.

Note: When specifying the search string, you can use . - : (period, dash, colon).

3 The Event Source Type drop-down menu filters for addresses containing all of the 

selected event source types.    

4  l Select the Show Acknowledged checkbox to display acknowledged Event Sources.

 l Mapping filter options can include just one of the mapping types listed in the Filter 
Panel, or multiple Mapping Types can be selected. 

Note: If no mapping filter options are selected, the default is to display All, None, 
Manual, and Auto mapping types.

5  l The Apply button uses all criteria that is set in all filters.

 l The Clear button clears all filters from the panel.

6 Toggles the event sources between acknowledged and not acknowledged states.

7 Maps the selected event sources.

8 View Details button to view details of the selected Event Source.

9 Displays the  addresses of the selected Event Sources.

10 Displays the discovery scores of the selected Event Sources.

11 Displays whether or not the selected Event Sources have been acknowledged.
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12 Displays the selected Event Source Mapping type as Auto, Manual, or None. Any 

changes to the mapping are only displayed here.

13 Displays the host names of the Log Collectors where the Event Sources are located.

14 Displays the host names of the Log Decoders where the Event sources are located.

15 Displays the discovered Event Source Types and their associated discovery scores.

Toolbar and Features

The Discovery tab contains the following features:

Field Description

Tools The following items are available on the toolbar:

 l Toggle Acknowledge: Toggles the acknowledged 
state for the selected Event Source between Yes and 
No.

 l Map: Opens the Manage Parser Mappings dialog 
box, where you can map an event source to the 
correct log parser.

 l View Details: Provides details on the selected Event 
Source.

Event Source The IP, IPv6, or Hostname of the Event Source.

Discovery Score Displays the overall discovery score associated with 
that particular address. Higher  scores indicate better 
confidence.  Discovery scores range from 0 (least 
confident) to 100 (most confident).

Acknowledged Selections are either  Yes (you have acknowledged the 

Event Source) or 

No (you have not acknowledged the Event Source).
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Field Description

Mapping Type Selections are  Manual (you mapped the Event Source), 

Auto (the system automatically mapped the Event 

Source), or None (you have not mapped the Event 

Source).

Note: This features applies to RSA NetWitness version 

11.1 and later.

Log Collector(s) Log Collectors that have received logs from this Event 
Source address.

Log Decoder(s) Log Decoders that have received logs from this Event 

Source address.

Event Source Type(s) The parsed type(s) of the Event Source address and the 

corresponding Discovery Score for each type. 

Note: Discovery Scores are only available for 11.0 and above Log Decoders. Discovery 
Scores for pre-11.0 Log Decoders display as Unavailable. 

The following table describes the sorting order for discovery scores. To access the Sorting Order 
drop-down menu,  click on the down arrow in the Event Sources column.

Field Description

Sort Ascending Sort the column by discovery score in ascending 
order.

Sort Descending Sort the column by discovery score in descending 
order.

Columns Used to hide or show one or more columns.
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Manage Tab
The Manage tab organizes event sources into groups, and displays attributes for each event 
source. 

To access this tab, go to ADMIN > Event Sources > Manage.

Workflow
This workflow shows the overall process for configuring event sources. 

What do you want to do?

Role I want to... Documentation

Administrator *View and modify event sources. Managing Event 

Source Groups

Administrator Acknowledge and map event sources. Acknowledging and 

Mapping Event 

Sources

Administrator Add and configure parser mappings for a Log 
Decoder

Manage Parser 
Mappings 

Administrator View event source alarms. Viewing Event 

Source Alarms

Administrator View log parser rules. Default Log Parser 
and Log Parser Rules 

Administrator Troubleshoot event source management. ESM 
Troubleshooting 
& Appendix
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*You can perform this task here.

Related Topics
Creating Event Source Groups

Creating an Event Source and Editing Attributes

Quick Look 
The Manage tab organizes event sources into groups, and displays attributes for each event 
source. The Manage tab consists of two panels, Groups and Event Sources.

Groups Panel

The Groups Panel lists the event source groups, as well as a count of the members for each 
group. To see all event sources, select All from the groups list. This is an example of the Groups 
panel.
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1 Displays the standard NetWitness Suite icons for adding, removing, or editing groups.

2 Lists the identifier for each group in the Name column. You can use the group names to 
quickly identify some of the criteria used to form the group.

For example, if you create a group that consists of Windows event sources for the Sales 
organization, you could name the group Windows Sales Sources.

Note: The event source group name is not editable. Once you create a group, that name 
exists as long as the group itself.

3 The count for an event source group indicates the number of event sources in that group. 
That is, the number of event sources that match the criteria used to define the group.

Note: The count is not dynamically updated when new event sources are added. Thus, 
you may need to refresh to see an updated group count.

Event Sources Panel

The Event Sources panel displays the attributes for the event sources in the selected group. Or, 
if All is selected in the Groups panel, the Event Sources panel lists all event sources.
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1 The toolbar contains the following tools:

 l Add: manually add an event source

 l Remove: remove an event source

 l Edit: Update attributes for an existing event source

 l Import / Export menu: Displays a menu with the following options: 

 l Import: Import event sources from a  Content Management Database (CMDB), 
spreadsheet, or other tool.

 l Export: Export selected event sources and their attributes in CSV format.

 l Export Group: Export the entire group that is currently selected.

 

2 Columnar display of attributes. You can choose which attributes to display.  

3 Actions: Shortcut menu for often-used commands: Edit, Delete, and Export.  
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4 Checkboxes: Select rows to use when performing tasks on multiple event sources, such 

as bulk editing.

 

5 Navigation Tools: 

At the bottom of the screen, there are items that help in navigating your group:

 l Page x of y: indicates which page you are currently displaying, and how many total 
pages exist for this group.

 l <<, <, > and >>: click these icons to move between pages either one at a time (< and 
>) or to the first (<<) or last (>>) page.

 l Page Size: use this selector to choose your page size.

 l Displaying x - y of z: quick check of which event sources are currently displayed out 
of the total number for the group.

 

Sorting

In the Event Sources panel, the list of items is presented in a sorted order. You can choose 
which column on which to sort. Note, however, that the sort order depends on capitalization. 

For any string column, if the values contains a mix of lower case and upper case, the upper 
case appear in the list before the lower case values.

For example, assume the Event Source Type column contains the following entries: Netflow, 
APACHE, netwitnessspectrum, ciscoasa. The sort order would be as follows:

 l APACHE

 l Netflow

 l ciscoasa

 l netwitnessspectrum
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Manage Event Source Tab
The Manage Event Source screen has several integrated components that present different 
perspectives of an event source.

 l Show Event Source Details

 l Add attribute values to an event source

 l Remove attribute values for an event source

To view the Manage Event Source screen for an event source:

 1. Go to ADMIN> Event Sources.

 2. Select the Manage tab.

 3. From the Event Sources pane, select an event source from the list and  click + .

Workflow

This workflow shows the end-to-process for modifying, acknowledging, mapping, and 
configuring event sources, along with viewing and configuring event source alarms and alerts.
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What do you want to do?

Role I want to... Documentation

Administrator Create an event source group that 
contains all the high priority event 
sources.

Creating Event Source Groups

Administrator Edit event source attributes. Creating an Event Source and 
Editing Attributes

Related Topics

Creating an Event Source and Editing Attributes

Creating Event Source Groups
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Quick Look

This is an example of the New Event Source tab:

This table describes event source attribute categories.

Event Source Management References 57



Event Source Management User Guide

Attribute Section Description

Identification These attributes are the main attributes that 
collectively identify an event source.

The following attributes are auto-populated, and 
cannot be changed while on this screen:

 l IP address

 l IPv6 value

 l Hostname

 l Event Source Type

These attributes can be modified:

 l Log Collector

 l Log Decoder

Properties These attributes provide the name and 
description.

 l Name

 l DNS Hostname

 l Description

Importance These attributes can be used for grouping by 
priority.

 l Priority

 l Criticality

 l Compliance

Zone These attributes can be used for grouping by 
zone.

 l WAN (Wide Area Network)

 l LAN (Local Area Network)

 l Security

 l Operational
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Attribute Section Description

Location These attributes can be used to group by the 
physical or geographical location.

 l Country

 l State

 l County

 l Province

 l City

 l Campus

 l Postal Code

 l Building

 l Floor

 l Room

Organization These attributes can be used to group by 
organization, and also to provide contact 
information.

 l Company

 l Division

 l Business Unit

 l Department

 l Group

 l Contact

 l Contact Phone

 l Contact Ema

Owner These attributes specify those responsible for the 
event source.

 l Manager

 l Primary Administrator

 l Backup Administrator
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Attribute Section Description

Physical These attributes specify the physical properties 
for the event source.

 l Vendor

 l Serial Number

 l Asset Tag

 l Voltage

 l UPS Protected

 l Rack Height

 l Depth

 l BTU Output

 l Color

Function These attributes can be used to group by function.

 l Primary Role

 l Sub Role 1

 l Sub Role 2

System Information These attributes specify system information.

 l Domain Name

 l System Name

 l Identifier

 l System Description

Custom This section provides eight custom attributes, for 
any other attributes that your organization might 
need.

Features

The settings in the Manage Event Source tab are a combination of auto-populated and user-
entered information. When an event source sends log information to NetWitness Suite, it is 
added to the list of event sources, and some basic information is auto-populated. At any time 
after that, users can add or edit details for other event source attributes.

This figure shows an example of the Identification, Properties, and Importance sections.
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This figure shows an example of the Zone, Location, and Organization sections.
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Event Sources View
The Event Source Attributes panel has the following tabs.

To access this panel, go to ADMIN > Event Sources.

Workflow

This workflow shows the end-to-process for modifying, acknowledging, mapping, and 
configuring event sources, along with viewing and configuring event source alarms and alerts.

What do you want to do?

Role I want to... Documentation

Administrator Create an event source group. Creating Event Source Groups

Administrator Edit or delete an event source 

group.

Editing or Deleting Event 
Source Groups

Administrator Edit event source attributes. Creating an Event Source and 
Editing Attributes

Related Topics

Managing Event Source Groups

Creating Event Source Groups

Editing or Deleting Event Source Groups

Creating an Event Source and Editing Attributes
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Quick Look

The Event Sources view presents the details for Event Sources that are discovered, 
acknowledged, or mapped by RSA NetWitness Suite.

1 Discovery Tab

Use this tab to review the event source types that NetWitness has discovered for each 
address and the system’s confidence of how likely it is that they were identified 
accurately. 

2 Manage Tab

Use this tab to create, edit, and delete Event Source Groups. It presents a customizable, 
searchable view of all of your event sources and groups.

3 Monitoring Policies Tab

Use this tab to manage alert configuration for event sources.

4 Alarms Tab

Use this tab to see the details of the alarms that have been generated.

5 Settings Tab

Use this tab to view or change the behavior for automatic (baseline) alerts.

6 Log Parser Rules Tab

Use this tab to display information about individual log parsers, as well as the default, 
"parse all" parser.

Note: The Log Parser Rules tab is only available in RSA NetWitness® Suite versions 
11.1 and later.
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Create/Edit Group Form
This Create Event Source Group form is displayed when you are creating or editing an Event 
Source Group.

Workflow
This workflow shows the overall process for configuring event sources. 

What do you want to do?

Role I want to... Documentation

Administrator *View and modify event sources. Managing Event 

Source Groups

Administrator Acknowledge and map events sources. Acknowledging and 

Mapping Event 

Sources

Administrator Add and configure parser mappings for a Log 
Decoder

Manage Parser 
Mappings 

Administrator View event source alarms. Viewing Event 

Source Alarms

Administrator View log parser rules. Default Log Parser 
and Log Parser Rules 

Administrator Troubleshoot event source management. ESM 
Troubleshooting 
& Appendix

*You can perform this task here.
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Related Topics
Creating Event Source Group Form

Managing Event Source Groups
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Details View
The Details view allows you to see details about the Event Source, as well as viewing a sample 
of the logs identified for each type in order to verify their accuracy. 

You can access the Details view in a couple of ways.

 l From the Toolbar, click the View Details button. Or, you can 

 l Double-click on the Event Source you selected.

Workflow
This workflow shows the overall process for configuring event sources. 

What do you want to do?

Role I want to... Documentation

Administrator View and modify event sources. Managing Event 

Source Groups

Administrator *Acknowledge and map events sources. Acknowledging and 

Mapping Event 

Sources

Administrator Add and configure parser mappings for a Log 
Decoder

Manage Parser 
Mappings 

Administrator View log parser details Manage Parser 

Mappings 
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Role I want to... Documentation

Administrator View log parser rules. Default Log Parser 
and Log Parser Rules 

Administrator Troubleshoot event source management. ESM 
Troubleshooting 
& Appendix

*You can perform this task here.

Related Topics
Viewing Logs from Pre-11.0 Log Decoder

Quick Look
The following example shows the discovery scores, event source types, logs, and attributes that 
correspond with the Event Source you selected in the Event Sources panel for a single Log 
Decoder.

Note: Device logs are only available for 11.0.0.0 and above Log Decoders. 

1 Displays the  address of the selected Event Source.

2 Displays the potential type of the selected Event Source.
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3 Displays the selected Event Source Mapping Type as Auto-Mapped, Manually Mapped, 
or None. Any changes to the Event Source Mapping are only displayed here.

4 Displays the discovery score for the selected Event Source type from least confident (0) 
to most confident (100).

5 Displays timestamps for the last few logs that have been parsed to the selected Event 

Source Type.

6 Displays the  address of the Log Decoder that is parsing event sources.

7 Displays the discovery score of the corresponding log.

8 Displays logs for the selected Event Source type.

9 Allows you to acknowledge that all the discovered Event Source types are correct.

10 Allows you to set the appropriate parsers for selected Event Source addresses.

11 Displays  the Event Source Management attributes for the selected Event Source Type.
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Manage Parser Mappings 
The Manage Parser Mappings dialog allows you to map the appropriate parsers for selected 
Event Source addresses. From the Details view, select the Map button.

Workflow
This workflow shows the overall process for configuring event sources. 

What do you want to do?

Role I want to... Documentation

Administrator View and modify event sources. Managing Event 

Source Groups

Administrator Acknowledge and map events sources. Acknowledging and 

Mapping Event 

Sources

Administrator *Add and configure parser mappings for a Log 
Decoder

Manage Parser 
Mappings 

Administrator View event source alarms. Viewing Event 

Source Alarms

Administrator View log parser rules. Default Log Parser 
and Log Parser Rules 

Administrator Troubleshoot event source management. ESM 
Troubleshooting 
& Appendix

*You can perform this task here.
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Related Topics
Viewing Logs from Pre-11.0 Log Decoder

 
Quick Look

1 Displays all the available  parsers that you can map based on the event sources that you 
selected from the Discovery view. Also displays the mappings that are already present in 
the Log Decoders for the selected event source or the parsers that have been discovered. 

To filter your available parsers, type the first few letters of the parser name that you want 
to map. 
Click the Add to Mapping button to add the parser to the parser mappings listed in the 
right panel. 

You need to select parsers before the Add toMapping button is enabled.

Add the selected parser by clicking the Add to Mapping button in the right panel.

You can rearrange the order of the parser mappings using the up and down arrow 
keys and you can also drag and drop selected parser mappings. You can select multiple 
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mappings by pressing the Ctrl key. 

2 Displays the names of the selected parsers that you want to map.

3 Displays the order of the selected parser mappings. 

You can delete parser mappings by selecting the minus sign  ( ). 
Press the Ctrl key to select multiple mappings to perform group operations on them.

4 Click Save to save your mappings to all the Log Decoders. A pop-up message informs 
you that your mappings are successfully saved. When the window is closed, the banner 
on the Details tab is updated to reflect the status. If mapped, the text displayed is 
Mapped. 
Click Cancel to return to the Details tab.

Advanced Configuration 

Mapping configurations with the Log Collector are not displayed in the Parser Mappings 
window. If the mapping is saved, it is saved for the corresponding IP address, not for the 
corresponding Log Collector entry. If no mappings are found for the corresponding IP address, 
the discovered event source types are displayed in the Parser Mappings window.

If  advanced Log Decoder configurations are discovered, a message similar to the one below 
displays in the Manage Parser Mappings dialog.

Note: If you want to edit the advanced configuration, you need to navigate to the Log Decoder 
service's parser mappings configuration.
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Alarms Tab
From the Alarms tab you can view details of the alarms that have been generated.

The Alarms tab has one panel that displays Alarm status. 

To access this tab, go to ADMIN  > Event Sources > Alarms.

Workflow 
This workflow shows the overall process for configuring event sources. It also shows where 
configuring alarms and alerts settings are located in the process.

 

What do you want to do?

Role I want to... Documentation

Administrator View and modify event sources. Managing Event 

Source Groups

Administrator Acknowledge and map events sources. Acknowledging and 

Mapping Event 

Sources

Administrator Add and configure parser mappings for a Log 
Decoder

Manage Parser 
Mappings 

Administrator *View event source alarms. Viewing Event 

Source Alarms
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Role I want to... Documentation

Administrator View log parser rules. Default Log Parser 

and Log Parser Rules 

Administrator Troubleshoot event source management. ESM 
Troubleshooting 
& Appendix

*You can perform this task here.

Related Topics
Configuring Automatic Alerting

Quick Look
The Alarms tab presents the details for Event Sources that are currently in violation of a policy 
and threshold. Only Event Sources in violation of a policy appear in the list. Once the event 
source returns to a normal state, the corresponding alarm disappears from the list.

1 Displays the IP, IPv6, or Hostname of the event source that is alarmed.

2 Displays the  type of the alarmed event source. For example, winevent_nic (for Microsoft 

Windows) or rhlinux (for Linux).

3 Displays the event source group that contains the event source for which the alarm has 

been triggered.

4 Displays the type of threshold that was triggered: High or Low

5 Displays the conditions of the threshold that was triggered. For example:

5,000,000 events in 5 minutes

6 Displays the number of events in the threshold time period causing the alarm.
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7 Displays the initial time the event source went into an alarmed state.

Note: When you first access this view, the data is sorted by this column (most recent 
alarm first).

8 Displays the elapsed time since the event source entered an alarmed state.

9 Displays the Log Collector last collecting from this event source.

10 Displays the Log Decoder last receiving from this event source.

11 Displays the alarm type. Alarm type is either Manual or Automatic:

 l Manual: these are alarms that violate the configured threshold policy.

 l Automatic: these are alarms that deviate from the baseline for the alarmed event 
source.

12 Select the Filter icon to display the Filter menu:

Select either Automatic or Manual:

 l If you select Automatic, only the alerts that are based on baselines are displayed.

 l If you select Manual, only the alarms for which you have set thresholds are displayed.

Note: You can hide or show columns by right-clicking in the table header and 
choosing Columns from the drop-down menu. Select a column to display it, or clear the 
column to hide it.
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Monitoring Policies Tab
The Monitoring Policies tab organizes thresholds by event source group.

To access this tab, go  to ADMIN > Event Sources. The Manage tab is displayed. Select 
the Monitoring Policies tab.

Workflow
This workflow shows the overall process for configuring event sources. 

What do you want to do?

Role I want to... Documentation

Administrator View and modify event sources. Managing Event 

Source Groups

Administrator Acknowledge and map events sources. Acknowledging and 

Mapping Event 

Sources

Administrator Add and configure parser mappings for a Log 
Decoder

Manage Parser 
Mappings 

Administrator View event source alarms. Viewing Event 

Source Alarms

Administrator *View Monitoring Policies. Monitoring Policies

Administrator Troubleshoot event source management. ESM 
Troubleshooting 
& Appendix
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*You can perform this task here.

Related Topics
Setting Up Notifications

Disabling Notifications

Quick Look
The Monitoring Policies tab consists of three panels:

 l Event Groups Panel

 l Thresholds Panel

 l Notifications Panel

This is an example of the Monitoring Policies tab.

1 Displays the Groups panel.

2 Displays the  Thresholds panel.

3 Displays the Notifications panel.
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Event Groups Panel

The group selected in this panel determines which thresholds appear in the Thresholds panel. 
You can define a set of thresholds for each event source group. Notice that the groups are listed 
in a specific order:

 l Drag and drop groups to change the specified order.

 l The higher a group is listed, the higher the precedence for that group's thresholds: RSA 
NetWitness Suite checks the thresholds in the order provided in this panel. Thus, your highest 
priority groups should be at the top of this list

Thresholds Panel

This is an example of the Thresholds panel for an event source group.
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The Thresholds Panel contains the following features.

Feature Description

Enable The Enable checkbox designates whether or not the 
thresholds that you define for a group are enabled. If so, 
notifications are sent whenever the thresholds for that group 
are outside of the defined range. If not, then no monitoring 
of that event source group is occurring.

Note: If you configure a threshold and attempt to save the 
page without enabling it, you receive a confirmation 
message, asking you whether or not to enable the policy.

If you enable a policy, but do not have any thresholds set, 
then you can still receive automatic (baseline) notifications, 
as long as you have turned on automatic notifications.

See below for more details on the look of notifications.

Low number of events

Low number of minutes or 

hours

This is the low end of the threshold. Enter the fewest 
number of events and the time range. If the event source 
group receives fewer messages than specified here, the 
threshold is not met, and notifications are sent.

High number of events

High number of minutes or 

hours

Works similarly as for the low values: If more messages 

than specified here are received, the threshold is not met, 

and notifications are sent.

Last Modified date and time This field indicates the last time and date that the thresholds 

were changed.

Save Saves the changes you have made to the thresholds.

Notifications Panel

This is an example of the Notifications panel for an event source group.
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The following table describes the fields on the Notifications panel

Field Description

Tools

+  -
The following items are available on the toolbar:

 l Add (+): clicking the Add presents a menu where you can choose the type of 
the notification

 l Remove (-): removes the selected row from the list.

Notification 

Settings

Clicking this link opens a new browser tab, and takes you to the Admin > 
System > Notifications page in NetWitness Suite.

Type Displays the type of the notification that you have chosen. The available options 
are as follows:

 l Email

 l SNMP

 l Syslog

Notification See the Configure Notification Outputs topic in the System Configuration 

Guide for more details.

Notification 
Server

See the Configure Notification Servers topic in the System Configuration 

Guide for more details

Template For Event Source Management, RSA provides three out-of-the-box templates for 
notifications. You can use the following templates as delivered, or customize 
them based on the needs of your organization:

 l Email template: sends notifications to the specified email addresses.

 l SNMP template: sends notifications to the specified SNMP server

 l Syslog template: sends notifications to the specified Syslog server.

See the Configure /Templates for Notifications topic in the System 
Configuration Guide for more details.
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Field Description

Output 

Suppression 

Use this item to limit how often notifications are received for this policy, in case 

a lot of alerts are triggered in a short period of time. 

The following are sample notifications, based on the supplied Templates.

 l Email:

For email notifications, the third column, Alarm Type, specifies whether the triggered 
alarm was based on a user threshold, or the baseline data being out of normal bounds. 
If you have automatic monitoring or notifications turned off, you will not receive any 
Automatic notifications. The same is true for Syslog and SNMP, except those 
notifications are formatted differently.

 l SNMP trap:

 11-11-2015 11:57:33 Local7.Debug 127.0.0.1 community=public, 

enterprise=1.3.6.1.4.1.36807.1.20.1, uptime=104313, agent_

ip=10.251.37.92, version=Ver2, 

1.3.6.1.4.1.36807.1.20.1="NetWitness Suite Event Source 

Monitoring Notification:

 Group: PCI Event Source(s)

 High Threshold:

 Greater than 500 events in 5 minutes

 10.17.0.10,ciscopix,Manual

 10.17.0.13,ciscopix,Manual
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 10.17.0.8,ciscopix,Manual

 10.17.0.8,ciscopix,Automatic

 10.17.0.12,ciscopix,Manual

 10.17.0.5,ciscopix,Manual

 10.17.0.6,ciscopix,Manual

 10.17.0.4,ciscopix,Manual

 10.17.0.4,ciscopix,Automatic

 10.17.0.3,ciscopix,Manual" 

 l Syslog sample:

 11-11-2015 11:57:33 User.Info 127.0.0.1 Nov 11 11:57:33 

localhost CEF:0|RSA|NetWitness Suite Event Source 

Monitoring|10.6.0.0.0| 

HighThresholdAlert|ThresholdExceeded|1|cat=PCI Event Source

(s)|Devices| 

src=10.17.0.10,ciscopix,Manual|src=10.17.0.13,ciscopix,Manual|sr

c=10.17.0.8,ciscopix,Manual|src=10.17.0.8,ciscopix,Automatic|src

=10.17.0.12,ciscopix,Manual|src=10.17.0.5,ciscopix,Manual|src=10

.17.0.6,ciscopix,Manual|src=10.17.0.4,ciscopix,Manual|src=10.17.

0.4,ciscopix,Automatic|src=10.17.0.3,ciscopix,Manual|
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Settings Tab
The Settings tab presents options for automatic monitoring (baseline alerting). To access this tab, 
go to ADMIN> Event Sources > Settings.

Workflow
This workflow shows the overall process for configuring event sources. 

What do you want to do?

Role I want to... Documentation

Administrator View and modify event sources. Managing Event 

Source Groups

Administrator Acknowledge and map events sources. Acknowledging and 

Mapping Event 

Sources

Administrator Add and configure parser mappings for a Log 
Decoder

Manage Parser 
Mappings 

Administrator View event source alarms. Viewing Event 

Source Alarms

Administrator *Configure Automatic Alerts. Automatic Alerting

Administrator Troubleshoot event source management. ESM 
Troubleshooting 
& Appendix

*You can perform this task here.
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Related Topics
 Automatic Alerting

Disabling Notifications

Quick Look
You can set up policies and thresholds for your event source groups. You do this so that you can 
receive notifications when the thresholds are not met. NetWitness Suite also provides an 
automatic way to receive alarms, if you do not want to set up thresholds to generate alarms.

About Automatic Alerting

You can set up policies and thresholds for your event source groups. You do this so that you 
receive notifications when the thresholds are not met. NetWitness Suite also provides an 
automatic way to receive alarms, if you do not want to set up thresholds to generate alarms.

To trigger automatic alerts, you can use baseline values. This way,  you do not need to set up 
numerous group thresholds and policies in order to receive alerts. Any anomalous amount of 
messages trigger alerts, without needing to do any configuration (except for turning on automatic 
alerting).

Note the following:

 l Once you begin collecting messages from an event source, it takes the system approximately 
a week to store a baseline value for that event source. After this initial period, the system 
alerts you when the number of messages for a period are above or below the baseline by a set 
amount. By default, this amount is 2 standard deviations above or below the baseline.

 l Base your high and low deviation settings on how "regular" your event sources behave. That 
is, if you expect little or no variance in the number of messages that arrive for a given time 
(for example, 8 to 9 am on a weekday), then you can set a low value for the Deviation. 
Conversely, if you often see peaks and valleys, set the Deviation value higher.

 l If you enable a policy, but do not have any thresholds set, then you can still receive automatic 
(baseline) notifications, as long as you have turned on automatic alerting.

Note: Automatic alerting, and it settings, are currently in Beta testing.
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1 Determines whether automatic alerting is on or off. By default, this option is selected 

(automatic alerting turned on)

2 Determines whether notifications for automatic alerts are on or off. By default, this option 
is cleared (automatic notifications are not sent when automatic alerts are triggered)

3 The standard deviations below which to receive alerts. Default is 2.5 (95% confidence)

4 The standard deviations above which to receive alerts. Default is 2.5 (95% confidence)

5 When selected, this option stores event source counts per one-hour interval. The data that 
is collected is used to form the baseline values for each event source.

 l Enabled (default): one count per hour per event source is stored in the underlying 
database. These one-hour counts (or aggregations) form the historical basis for 
computing the normal range for each event source.

 l Disabled: when the SMS Server is restarted, Event Source Monitoring will have no 
historical data with which to compute the normal range and the user will have to wait 
until enough data (about a week's worth) is collected to form a new basis for each 
event source

6 Controls how much historical data (see Enable Aggregation Persistence) to maintain for 

each event source. The default value of 120 days means roughly 4 months of history is 
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kept and used when reconstructing the basis for each event source

7 When enabled, data about the behavior of the automatic alerting is stored to disk. The 
default value is Enabled.

The data retained includes baseline value over time and the alerting history for each event 
source. Note, however, the event source address and type is anonymized, so only your 
event rate information is revealed.

Since automatic alerting is a beta feature, this data is important to measure the efficacy of 
the feature. This can be disabled without affecting the automatic alerting functionality

8 The Reset option discards any unsaved changes for all settings on the page.

9 Click Apply to save any changes you made to the values on the page.

Features

The Settings tab contains the following features.

Feature Description

Enable 

Automatic 

Monitoring  

Determines whether automatic alerting is on or off. By default, this option is 
selected (automatic alerting turned on)

Enable 

Notifications 

From Automatic 

Monitoring 

Determines whether notifications for automatic alerts are on or off. By 
default, this option is cleared (automatic notifications are not sent when 
automatic alerts are triggered)

Low Standard 

Deviations 

The standard deviations below which to receive alerts. Default is 2.5 (95% 
confidence)

High Standard 

Deviations 

The standard deviations above which to receive alerts. Default is 2.5 (95% 
confidence)
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Feature Description

Enable 

Aggregation 

Persistence 

When selected, this option stores event source counts per one-hour interval. 
The data that is collected is used to form the baseline values for each event 
source.

 l Enabled (default): one count per hour per event source is stored in the 
underlying database. These one-hour counts (or aggregations) form the 
historical basis for computing the normal range for each event source.

 l Disabled: when the SMS Server is restarted, Event Source Monitoring 
will have no historical data with which to compute the normal range and 
the user will have to wait until enough data (about a week's worth) is 
collected to form a new basis for each event source

Aggregation 

Persistence 

Interval in 

Days 

Controls how much historical data (see Enable Aggregation Persistence) 
to maintain for each event source. The default value of 120 days means 
roughly 4 months of history is kept and used when reconstructing the basis 
for each event source

Enable 

Generation of 

Analytics 

When enabled, data about the behavior of the automatic alerting is stored to 
disk. The default value is Enabled.

The data retained includes baseline value over time and the alerting history 
for each event source. Note, however, the event source address and type is 
anonymized, so only your event rate information is revealed.

Since automatic alerting is a beta feature, this data is important to measure 
the efficacy of the feature. This can be disabled without affecting the 
automatic alerting functionality

Reset This option discards any unsaved changes for all settings on the page.

Apply Click Apply to save any changes you made to the values on the page.
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Log Parser Rules Tab

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

The Log Parser Rules tab displays information about individual log parsers, as well as the 
default, "parse all" parser that can parse logs that are not associated with a particular log parser. 
To access this tab, go to ADMIN > Event Sources > Log Parser Rules.

This tab contains the following information:

 l You can view the rules for a particular event source type, including the default parser.

 l You can view the Names, Literals, patterns, and meta for each configured log parser.

Workflow
This workflow is separate from the overall process for configuring event sources.

What do you want to do?

Role I want to... Documentation

Administrator View and modify event sources. Managing Event 

Source Groups

Administrator Acknowledge and map events sources. Acknowledging and 

Mapping Event 

Sources

Administrator Add and configure parser mappings for a Log 
Decoder.

Manage Parser 
Mappings 
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Role I want to... Documentation

Administrator View event source alarms. Viewing Event 

Source Alarms

Administrator *View log parser rules. Default Log Parser 

and Log Parser Rules 

Administrator Troubleshoot event source management. ESM 
Troubleshooting 
& Appendix

*You can perform this task here.

Related Topics
Default Log Parser and Log Parser Rules 

Creating Event Source Groups

Creating an Event Source and Editing Attributes

Viewing Logs from Pre-11.0 Log Decoder

Quick Look
Note: The list of log parsers is based on the first Log Decoder that is installed or registered by 
the Orchestration Server. If you have more than one Log Decoder, this tab only lists log 
parsers that configured on the first one.

The Log Parser Rules tab organizes displays information about the configured log parsers in your 
system. This tab consists of three panels: Log Parsers list, Details for the selected log parser, 
and Rules for the selected log parser.
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Log Parsers List Panel

The Log Parsers Panel lists the configured log parsers. Select 
a specific log parser to view its details in the Details and 
Rules panels.

Details Panel

The details panel shows the token matching, value matching, and mapping information for the 
selected log parser. Additionally, it shows how a sample log message is parsed.
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1 Displays the name of the selected log parser, and the currently selected rule. This value 
changes when you select a different rule for this parser.

2 Displays the token matching for the selected log parser. The values here are determined 
by the selected Rule.

3 Displays the type and pattern of the value matching for the selected parser. The values 
here are determined by the selected Rule.

4 Displays the NetWitness meta to which the selected rule maps any matched tokens. The 
values here are determined by the selected Rule.

5 Displays a sample log message, and highlights strings that match tokens in the selected 
log parser. You can edit this field, and add in your own logs to preview how the selected 
parser will parse your logs.

For example, consider the following scenario:

 l The default parser is selected.

 l The Any Domain rule is selected.

 l The Tokens matching list displays all of the tokens that are matched when found in a log 
message: Domain, Domain Name, domain, ADMIN_DOMAIN, and so on.
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 l The Meta list displays the NetWitness meta to which the value for the token is mapped: 
domain.

So, let's say the sample log message area has the following text:

Below are sample log messages:

May 5 2010 15:55:49 switch : %ACE-4-400000: IDS:1000 IP Option Bad Option List by user 
admin@test.com from 10.100.229.59 to 224.0.0.22 on port 12345.

Apr 29 2010 03:15:34 pvg1-ace02: %ACE-3-251008: Health probe failed for server 
218.83.175.75:81, connectivity error: server open timeout (no SYN ACK) domain google.com with 
mac 06-00-00-00-00-00.

In this case, the Sample Log Message area looks like this:

Note that some strings are highlighted, and that there are two "pairs" of highlight colors:

 l Dark blue and light blue highlighting is applied to the strings that match the currently selected 
rule.

 l Dark Blue highlighted strings match a token in the selected rule. In this case, domain is 
the token that is matched for the Any Domain rule.

 l Light Blue highlighted strings are the values that correspond to the tokens in dark blue. For 
example, google.com is highlighted in light blue, because it corresponds to the domain 
token.
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 l Orange and yellow highlighting is applied to the strings that match rules for the current parser 
that are not currently selected.

 l Orange highlighted strings match a token in a rule that is not currently selected.

 l Yellow highlighted strings are the values that correspond to the tokens in orange. For 
example, the user token matches the Username rule (which is not currently selected).

In this example, the domain meta would be assigned a value of google.com for this log message, 
if it was parsed using the default log parser.

Rules Panel

The Rules panel displays the list of rules used by the selected log parser. When you select a 
rule, you change the values that are displayed in both the Tokens and Values areas of the panel.

Note the highlighted rules:

 l The currently selected rule is highlighted in blue.

 l Other rules that match tokens in the sample log message 
area are highlighted in orange.
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Default Log Parser and Log Parser Rules 

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

This tab displays information about pattern matching and rules for the parsers in your system. 
The features on this tab apply to all log parsers, , including the Default Log Parser

Default Log Parser

The NetWitness Suite default log parser is used to parse logs coming from the Log Decoder that 
do not match any of the configured log parsers. This default parser parses these logs by using a 
default set of rules and tokens.

You can view the default log parser and its details by going to ADMIN > Event Sources > Log 
Parser Rules and selecting default from the Log Parsers panel.

Note: The list of log parsers is based on the first Log Decoder that is installed or registered by 
the Orchestration Server. If you have more than one Log Decoder, this tab only lists log 
parsers that configured on the first one.

This is a view of the Log Parser Rules tab, showing the Default Log Parser and Any Domain 
rule selected:

The Log Parser Rules Tab topic describes the items available for the Log Parsers tab.
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Highlight Matching Patterns

You can paste logs into the Log Messages text box, and the system highlights the matching 
literals and patterns for the rules for the selected event source type. Use this feature to confirm 
that the parser is behaving as expected.

 1. In the NetWitness Suite UI, navigate  to ADMIN > Event Sources > Log Parser Rules.

 2. From the Log Parsers pane, select a log parser.

 3. From the Rules pane, select a rule.

For example, this screen shows the Any Port rule for the cisopix log parser:

 4. Add text or paste in a sample log message.

Strings that match tokens for the selected rule are highlighted in blue. Strings that match other 
rules for the parser (and the rules themselves)  are highlighted in orange.
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For example, in the previous screen, note:

 l The source email address, matching the from token, is highlighted in blue. The token is in 
dark blue, and the matching string is highlighted in light blue. This is because the Source 
Email Address is the currently selected Rule.

 l The strings highlighted in orange match tokens for rules for Any MacAddress, Any Port and 
Source Port. This is because they are in rules for the ciscopix parser that are not currently 
selected.
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ESM Troubleshooting & Appendix
Troubleshooting Topics:

 l Alarms and Notifications Issues

 l Duplicate Log Messages

 l Troubleshooting Feeds

 l Import File Issues

 l Negative Policy Numbering

Appendix: Viewing Logs from Pre-11.0 Log Decoder

Alarms and Notifications Issues
This topic describes how to address problems you may encounter with alarms or notifications.

Alarms

If you are not seeing alarms that you expect to see, make sure that you have configured all the 
necessary items, as discussed below.

Automatic Alarms

To see automatic alarms appear on the Alarms screen, the Enable Automatic 
Monitoring option must be selected.

This option is on the Setting tab (ADMIN > Event Sources > Settings), and is selected by 
default. However, at some point someone may have cleared this option.

Manual Alarms

To see manual alarms appear on the Alarms screen, all of the following conditions must be met:

 l The event source must be part of a Group.

 l The Group must have a policy with either a low or high (or both) threshold defined.

 l The Group Policy must be enabled.

Notifications

If you are seeing alarms, but are not receiving the expected notifications, make sure that you 
have configured all the necessary items, as discussed below.
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Also, make sure that you have correctly configured the Notification Servers and Notification 
Outputs. Much of the preliminary configuration for Notifications is done from ADMIN > 
System > Global Notifications. For details, see the Global Notifications Panel topic in the 
System Configuration Guide.

Automatic Notifications

To have the system send automatic notifications, all of the following conditions must be met:

 l The Enable Automatic Monitoring option must be selected (this option is selected by 
default).

 l The Enable Notifications From Automatic Monitoring option must be selected. This option 
is cleared by default, so you or someone in your organization must select it. Navigate 
to ADMIN > Event Sources > Settings to see this option.

 l The event source that triggered the alarm must be in a group that has a policy enabled: note 
that no thresholds need to be set for automatic notifications.

 l The policy must at least one notification configured (either email, SNMP or Syslog).

Manual Notifications

To have the system send manual notifications (that is, a notification which says that a manual 
alarm was triggered):

 l The event source that triggered the alarm must be in a group that has a group policy enabled.

 l There must be a threshold set for the policy.

 l At least one notification has been configured for the policy.

Duplicate Log Messages
It is possible that you are collecting messages from the same event source on two or more Log 
Collectors. This topic describes the problem and ways to troubleshoot the issue.

Details

If the ESM aggregator detects the same events for the same event source on multiple Log 
Collectors, you receive a warning similar to the following:
2015-03-17 15:25:29,221 [pool-1-thread-6] WARN  
com.rsa.smc.esm.groups.events.listeners.EsmStatEventListener - 
 192.0.2.21-apache had a previous event only 0 seconds ago; likely 
because it exists on multiple log collectors
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This warning message means the 192.0.2.22-apache event source is being collected by 
multiple hosts. You can see the list of hosts in the Log Collector column in the Manage tab in 
the Administration > Event Sources view.

Clean Up Duplicate Messages

 1. Stop collectd on NetWitness Suite and Log Decoders:

service collectd stop

 2. Remove the ESM Aggregator persisted file on NetWitness Suite:

rm /var/lib/netwitness/collectd/ESMAggregator

 3. Reset the Log Decoder. 

 a. Navigate to the Log Decoder REST, at http://<LD_IP_Address>:50102.

 b. Click decoder(*) to view the properties for the decoder.

 c. In the Properties drop-down menu, select reset, then click Send.

 4. In the Event Sources panel from the Event Sources Manage tab, select all event sources and 

then click - to remove them.

 5. Start the collectd service:
service collectd start

Troubleshooting Feeds
The purpose of the feed generator is to generate a mapping of an event source to the list of 
groups to which it belongs.

If you have an event source from which you are collecting messages, and yet it is not displayed 
in the correct event source groups, then this topic provides background and information to help 
you track down the problem.

Details

The ESM Feed maps multiple keys to single value. It maps the DeviceAddress, Forwarder, 
and DeviceType attributes to groupName.

The purpose of the ESM feed is to enrich event source Meta with the groupName collected on 
the Log Decoder.
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How it Works

The feed generator is scheduled to update every minute. However, it is triggered only if there 
are any changes (create,  update, or delete) in event sources or groups.

It generates a single feed file with event source to group mapping, and pushes the same feed to 
all of the Log Decoders that are connected to NetWitness Suite.

Once the feed file is uploaded on the Log Decoders, for any new events, it enriches events Meta 
data with groupName, and appends this groupName to logstats.

Once the groupName is in logstats, the ESM Aggregator groups information and sends it to 
ESM. At this point, you should see the Group Name column under the Event Source 
Monitoring tab.

The entire process can take some time. Therefore, you may need to wait for several seconds 
after you add a new group or event source, before the Group name is displayed.

Note: If the event source type attribute changes when the feed is updated, NetWitness Suite 
adds a new logstats entry, rather than updating the existing one. Thus, there will be 
two different logstats entries in logdecoder. Previously existing messages would have been 
listed under the previous type, and all new messages are logged for the new event source type.

Feed File

The format of the feed file is as follows:
DeviceAddress, Forwarder, DeviceType, GroupName

The DeviceAddress is either ipv4, ipv6, or hostname, depending on which of these have 
been defined for the event source.

The following is a sample of the feed file:

"12.12.12.12","d6","NETFLOW","grp1"
"12.12.12.12","ld4","netflow","grp1"
"12.12.12.12","d6","netfow","grp1"
"0:E:507:E6:D4DB:E:59C:A","10.25.50.243","apache","Apac
hegrp"
"1.2.3.4","LCC","apache","Apachegrp"
"10.100.33.234","LC1","apache","Apachegrp"
"10.25.50.248","10.25.50.242","apache","Apachegrp"
"10.25.50.251","10.25.50.241","apache","Apachegrp"
"10.25.50.252","10.25.50.255","apache","Apachegrp"
"10.25.50.253","10.25.50.251","apache","Apachegrp"
"10.25.50.254","10.25.50.230","apache","Apachegrp"
"10.25.50.255","10.25.50.254","apache","Apachegrp"
"13.13.13.13","LC1","apache","Apachegrp"
"AB:F255:9:8:6C88:EEC:44CE:7",,"apache","Apachegrp"
"Appliance1234",,"apache","Apachegrp"
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"CB:F255:9:8:6C88:EEC:44CE:7","10.25.50.253","apache","
Apachegrp"

Troubleshooting Feeds

You can check the following items to narrow down where the problem is occurring.

10.5 Log Decoders

Are your NetWitness Suite Log Decoders at version 10.5 or later? If not, you need to upgrade 
them. For NetWitness Suite version 10.6, feeds are sent only to version 10.5 and later Log 
Decoders. 

Feed File Existence

Verify that the feeds ZIP archive exists in the following location:
/opt/rsa/sms/esmfeed.zip

Do not modify this file.

Group Meta Populated on LD

Verify that the group meta is populated on the Log Decoder. Navigate to the Log Decoder REST 
and check logstats:
http://LogDecoderIP:50102/decoder?msg=logStats&force-content-
type=text/plain

This is a sample logstats file with group information:

device=apache  forwarder=NWAPPLIANCE10304  source=1.2.3.4  
count=338  lastSeenTime=2015-Feb-04 22:30:19  
lastUpdatedTime=2015-Feb-04 22:30:19
groups=IP1234Group,apacheGroup
device=apachetomcat  forwarder=NWAPPLIANCE10304  
source=5.6.7.8  count=1301  lastSeenTime=2015-Feb-04 
22:30:19  lastUpdatedTime=2015-Feb-04 22:30:19
groups=AllOtherGroup,ApacheTomcatGroup

In the above text, the group information is bolded.

Device Group Meta on Concentrator

Verify that the Device Group meta exists on the Concentrator, and that events have values for 
the device.group field.
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SMS Log File

Check the SMS log file in the following location to view informational and error messages: 
/opt/rsa/sms/logs/sms.log

The following are example informational messages:

 Feed generator triggered...

 Created CSV feed file.

 Created zip feed file.

 Pushed ESM Feed to LogDeocder : <logdecoder IP> 

The following are example error messages:

 Error creating CSV File : <reason>Unable to push the 
ESM Feed: Unable to create feed zip archive.
Failed to add Group in CSV: GroupName: <groupName> : 
Error: <error>
Unable to push the ESM Feed: CSV file is empty, make 
sure you have al-least on group with al-least one 
eventsource.
Unable to push the ESM Feed: No LogDecoders found.
Unable to push the ESM Feed: Unable to push feed file 
on LogDecoder-<logdecoderIP>Unable to push the ESM 
Feed: admin@<logdecoderIP>:50002/decoder/parsers 
received error: The zip archive 
"/etc/netwitness/ng/upload/<esmfeedfileName>.zip" could 
not be opened
Unable to push the ESM Feed: <reason>
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Verify Logstats data is getting Read & Published by ESMReader & ESMAggregator

These are the steps to verify that logstats are collected by collectd and published to 
Event Source Management.

ESMReader

 1. On Log Decoders add debug "true" flag in /etc/collectd.d/logdecoder-esm.conf:

 #

# Copyright (c) 2014 RSA The Security Division of EMC

#

<Plugin generic_cpp>    PluginModulePath "/usr/lib64/collectd"

    debug "true"

    <Module "NgEsmReader" "all">

        port      "56002"

        ssl       "yes"

        keypath   "/etc/pki/nw/node/node-key.pem"

        certpath  "/etc/pki/nw/node/node-cert.pem"

        interval  "600"

        query     "all"

        <stats>

        </stats>

    </Module>

    <Module "NgEsmReader" "update">

        port      "56002"

        ssl       "yes"

        keypath   "/etc/pki/nw/node/node-key.pem"

        certpath  "/etc/pki/nw/node/node-cert.pem"

        interval  "60"

        query     "update"

        <stats>

        </stats>

    </Module>

</Plugin> 

 2. Run the command:

collectd service restart

 3. Run the following command:

tail –f /var/log/messages | grep collectd
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Verify that ESMReader is reading logstats and there are no errors. If there are any read 
issues, you will see errors similar to the following:

 ​Apr 29 18:47:45 NWAPPLIANCE15788 collectd[14569]: DEBUG: NgEsmReader_

all: error getting ESM data for field "groups" from logstat 

device=checkpointfw1 forwarder=PSRTEST source=1.11.51.212. Reason: 

<reason>Apr 29 18:58:36 NWAPPLIANCE15788 collectd[14569]: DEBUG: 

NgEsmReader_update: error getting ESM data for field "forwarder" from 

logstat device=apachetomcat source=10.31.204.240. Reason: <reason>​

ESMAggregator

 1. On NetWitness Suite, uncomment the verbose flag in /etc/collectd.d/ESMAggregator.conf:

 # ESMAggregator module collectd.conf configuration file

#

# Copyright (c) 2014 RSA The Security Divsion of EMC

#

<Plugin generic_cpp>

PluginModulePath "/usr/lib64/collectd"

<Module "ESMAggregator">

        verbose 1

        interval "60"

        cache_save_interval "600"

        persistence_dir "/var/lib/netwitness/collectd"

</Module>

</Plugin> 

 2. Run the following:

collectd service restart.

 3. Run the following command:

run “tail –f /var/log/messages | grep ESMA

Look for ESMAggregator data and make sure your logstat entry is available in logs.

Sample output:

 Mar  1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: 

MetaData[0] logdecoder[0] = d4c6dcd4-6737-4838-a2f7-ba7e9a165aae

Mar  1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: 

MetaData[1] logdecoder_utcLastUpdate[0] = 1425174451

Mar  1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: 

MetaData[2] groups = Cacheflowelff,Mixed

Mar  1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: 
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MetaData[3] logdecoders = d4c6dcd4-6737-4838-a2f7-ba7e9a165aae

Mar  1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: 

MetaData[4] utcLastUpdate = 1425174451

Mar  1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: 

Dispatching ESM stat NWAPPLIANCE15788/esma_update-cacheflowelff/esm_

counter-3.3.3.3 with a value of 1752 for 

NWAPPLIANCE15788/cacheflowelff/esm_counter-3.3.3.3 aggregated from 1 log 

decoders

Mar  1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: 

MetaData[0] logdecoder[0] = 767354a8-5e84-4317-bc6a-52e4f4d8bfff

Mar  1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: 

MetaData[1] logdecoder_utcLastUpdate[0] = 1425174470

Mar  1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: 

MetaData[2] groups = Cacheflowelff,Mixed

Mar  1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: 

MetaData[3] logdecoders = 767354a8-5e84-4317-bc6a-52e4f4d8bfff

Mar  1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: 

MetaData[4] utcLastUpdate = 1425174470

Mar  1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: 

Dispatching RRD stat NWAPPLIANCE15788/esma_rrd-cacheflowelff/esm_

counter-3.3.3.3 with a value of 1752 for 

NWAPPLIANCE15788/cacheflowelff/esm_counter-3.3.3.3 aggregated from 1 log 

Configure JMX Feed Generator Job Interval

Although the feed generation job is scheduled to execute every minute by default, you can 
change this by using jconsole, if necessary.

To change the feed generator job interval:

 1. Open jconsole for the SMS service.

 2. On the MBeans tab, navigate to com.rsa.netwitness.sms > API > esmConfiguration > 
Attributes.

 3. Modify the value for the property FeedGeneratorJobIntervalInMinutes.

 4. Go to Operations under the same navigation tree, an click commit(). This persists the new 
value in the corresponding json file under /opt/rsa/sms/conf, and uses the value if SMS is 
restarted.

​Setting a new value reschedules the feed generator job for the new interval.

ESM Troubleshooting & Appendix 105



Event Source Management User Guide

Import File Issues
If your import file is not formatted correctly, or is missing required information, an error is 
displayed, and the file is not imported.

Check the following:

 l If you are adding unknown sources, each line in the file must contain a combination of the 
required attributes: 

 l IP or IPv6 or Hostname, and

 l Event Source Type

 l The first line of the file must contain header names, and the names must match the names in 
NetWitness Suite. To get a list of correct column names, you can export a single event 
source. Examine the exported CSV file: the first row of the file contains the correct set of 
attribute/column names.

Negative Policy Numbering
You may see negative numbers in the Order field in the Groups section of the Monitoring 
Polices tab. This topic describes a workaround to restore the correct numbering scheme for your 
policies.

Details

The following screen shows an example of the situation where the numbers of group policies 
become negative.

106 ESM Troubleshooting & Appendix



Event Source Management User Guide

If you encounter this situation, drag and drop the top group (All Unix Event Source(s) in the 
above image) to after the last group (Ciscoasa_Alarm14417). This restores normal, ordinal 
numbering. You can then continue to drag and drop groups until you have them in their proper 
order for your organization.

Clean Up Duplicate Messages

 1. Stop collectd on NetWitness Suite and Log Decoders:

service collectd stop

 2. Remove the ESM Aggregator persisted file on NetWitness Suite:

rm /var/lib/netwitness/collectd/ESMAggregator

 3. Reset the Log Decoder.

 a. Navigate to the Log Decoder REST, at http://<LD_IP_Address>:50102

 b. Click decoder(*) to view the properties for the decoder.

 c. In the Properties drop-down menu, select reset, then click Send.

 4. In the Event Sources panel from the Event Sources Manage tab, select all event sources and 

then click - to remove them.

 5. Start the collectd service:
service collectd start

Viewing Logs from Pre-11.0 Log Decoder
RSA NetWitness® Suite 11.0 added the capability to view a small sampling of recent logs for 
specific devices through detail tabs of the Discovery View. By default, Log Decoders prior to 
11.0 do not have the necessary configuration to enable this feature, but a few minor changes can 
make it available.

To enable logs preview for a pre-11.0.0.0 Log Decoder, follow these steps on the Log Decoder:

 1. Go to ADMIN > Services > select a Log Decoder, then select  > View > Config.

 2. Click Files tab, then select index-logdecoder-custom.xml from the drop-down menu.

 3. Add the following three lines at the end of the file (before the closing language tag):
<key description="Device IP" level="IndexValues" name="device.ip" format="IPv4" 
valueMax="100000" defaultAction="Open"/>
<key description="Device IPv6" level="IndexValues" name="device.ipv6" format="IPv6" 
valueMax="100000" defaultAction="Open"/>
<key description="Device Host" level="IndexValues" name="device.host" format="Text" 
valueMax="100000" defaultAction="Open"/>
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 4. Click Apply.

 5. Restart the Log Decoder as follows.

Select Log Decoder > Explore > sys > Properties > shutdown

This is an example  of the index-logdecoder-custom.xml file.

Note: Discovery Scores are only available for 11.0 and above Log Decoders. Discovery 
Scores for pre-11.0 Log Decoders display as Unavailable. 

The following example displays the Discovery Score  as Unavailable in the Details view for a 
pre-11.0 Log Decoder.
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Note: Device logs are only available for 11.0 and above Log Decoders. 

The following example shows the message that displays in the displays in the Logs panel for a 
pre-11.0 Log Decoder.
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